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How to begin?
1. Run an instance of Mod3D application. At the beginning two views of an
empty document are opened automatically, map view and profile view. If
you closed previously opened document select from menu File \ New.
2. Now choose between two possibilities how to create observations.
If you want to create planar observation area, select from menu Model
\ Define Observations and enter coordinates to Define Observation
dialog. See also Mod3D Coordinate system.
Second way is to import Digital Elevation Model (DEM) grid. Choose
from menu Model \ Import Observation. You will be asked to set the
vertical range. Within this range a model can be defined, and it is also
used for scaling views to fit the window. You can change vertical
range later in menu Model \ Change Vertical Range.
3. Open new Profile View window. Choose from menu Window \ New Profile
Window. Or use shortcut toolbar button .
4. Use Model toolbar buttons
or keyboard arrows
keys to move across the observation area. Move to the profile, where you
would like to create a body (i.e. to the middle of the observation area). To
create new body click right mouse button at the position where you want to
insert new body. This will open floating menu. From floating menu choose
Insert New Body. In Body Properties property page, set the physical
properties, drawing parameters of the body and description. The body is
created. Cursor will change to
if the vertex is movable. Now the body
can be modified after clicking on the vertex, hold left mouse button down
and move mouse in vertical direction. Body can be extended to the sides
after the cursor changes to
on the vertical body edge to . Then hold left
mouse button down and move mouse to the side (at the beginning of body
creation you MUST move to the right).
5. The simpliest way how to extend the body to the next profile follows. Click
the right mouse button inside the body. From the floating menu choose
Copy to Next Profile or Copy to Previous profile. The system will copy the
body to the next or previous profile respectivelly.
6. Move to the next profile using model toolbar buttons ad reshape the body.
7. Finally compute the field using command from menu Compute \ Compute.
Or use shortcut button
from main tooldbar .

How to Create / Modify the model?
NOTE: Most of described operations are performed in the Profile
View! Only vertex motion can be additionally used in 3D View.
Conventions in following description:
Actions.
left mouse button click–> click with left mouse button
left mouse button down –> left mouse button is down
right mouse button click–> click with right mouse button
right mouse button down –> right mouse button is down
mouse double click -> double click with left mouse button
mouse move -> mouse is moving
CTRL – Ctrl button on keyboard is down
SHIFT – Shift button on keyboard is down
Use Model toolbar buttons or keyboard arrows to move across the observation
area and move to the profile where you would like to create a body .
Create new body.
To create a new body use right mouse button click at position in Profile
View where you want to insert a body. You MUST click inside the "model area",
what is an area inbetween relief and bottom boundary of the model
vertical range, when the cursor changes to
. Right mouse button click opens
floating menu, where choose Insert New Body command. Right mouse button
click on the newly created body opens the floatin menu, where choose Properties
. In the Body Properties property page, modify the physical properties, drawing
parameters and description of the body. The "body" is created at given
position. The way how the body will be further extended is given by Body
Creation Properties. To extend the body to the sides follow Body extending to
the side below.
Creating a new separated part of an existing body.
Use the same steps as described in the Create new body section, but choose
Insert Existing Body from floating menu. In Insert Existing Body dialog select
the body you want to create. The initial body width is by default 1/10 of the

model vertical range. In a case that you may want to change the body properties
of the separate part of some body in the future, better create new body.
Moving body vertices.
Cursor changes to
if the vertex is movable in vertical direction. Catch the
vertext with left mouse button click . Use left mouse button down + move mouse
in vertical direction along the grid lines. The limits where the vertex can move
are defined by the geometry of the model. Body vertex can not move inside to
another body or cross another vertex of the same body. Also cannot move above
the relief or below the model range minimum. If you would like to extent the
body deeper then change vertical model range minimum. Use from
menu Model \ Change Vertical Range command, though. If real-time
computation mode in on, the modeled field is gonna be updated.
Body extending to the side.
Body can be extended to the sides after the cursor changes to
when moving
with mouse cursor over the vertical body outer or inner edge. Click left mouse
button and extend the body to the side using left mouse button down + move
mouse. If you are moving towards outside from the body new parts are created.
Moving towards inside the body will remove the last edge. One MUST point
with the cursor over next (previous) vertical line in order to create new part of
the body. Rules how new part of a body is created is defined in menu Body \
Creation Properties. In the case of moving towards the edge of separate part of
the same body, the two parts will be merged. One cannot enter to another body.
In that case operation will be stopped. If real-time computation mode in on, the
modeled field is gonna be updated.
Modifying shape of the body.
Simply left mouse button click on the body vertex and use left mouse button
down + mouse move and modify the shape. You can modify vertical vertex
position moving along the vertical grid line. To modify next vertex keep the
mouse capture and move to the next grid line. This is something like imitation of
the boundary drawing. If two bodies have common boundary, it is modified
automatically. Upper and lower boundary of a body MUST be modified
separately. If real-time computation mode in on, the modeled field is gonna be
updated.
Connect vertices.
In most cases the two neighboring bodies have common boundary. To connect

vertices of two neighbouring bodies in vertical direction together drive the body
vertex towards the body which is to be connected using left mouse button down
+ mouse move. If the cursor passes over neighbouring body, the vertices are
joined together. You can also apply above rules to join body to relief. In cases
when two vertices are close to each other (in screen coordinates) they will be
connected automatically after clicking on one of the vertices. There is no
limitation for how many bodies could be connected ogether. If real-time
computation mode in on, the modeled field is gonna be updated.
Disconnect vertices.
To disconnect common vertex of two or more bodies use CTRL + left mouse
button down + mouse move. Continue to move mouse (like Modifying shape of a
body) to disconnect another vertices. The vertices of two bodies can be
disconnected only in one direction, depending on the internal storage order of
the bodies.
Connect end of a body into one vertex.
Use left mouse button down + mouse move and connect the vertices together.
Move body in vertical direction.
Use SHIFT + left mouse button down + mouse move to move the body in
vertical direction. Cursor MUST be of 'over body'
type. To controll body
motion manually, use fom floating body menu command Move Body.

Complex model.
In a complex model common vertical boubaries are NOT
supported! You always MUST connect the termination of a body
from each side on a given profile into one common vertex!

File menu commands
The File menu offers the following commands:
New
Open
Close
Save
Save As
Import
Print
Print Preview
Print Setup
Exit

Creates a new document.
Opens an existing document.
Closes an opened document.
Saves an opened document using the same file name.
Saves an opened document to a specified file name.
Imports aditional files
Prints a document.
Displays the document on the screen as it would appear printed.
Selects a printer and printer connection.
Exits Mod3D.

View menu commands
The View menu offers the following commands:
Toolbar
Status Bar

Shows or hides the toolbar.
Shows or hides the status bar.

Compute menu commands
The Compute menu offers the following commands:
Compute
Properties
Ative
Field

Computes model fields.
Shows computation properties.
Customizes active field for effective
computation.

Window menu commands
The Window menu offers the following commands, which enable you to arrange
multiple views of multiple documents in the application window:
New Profile Window
New Map Window
New 3D Window
Cascade
Tile Horizontally
Tile Vertically
Arrange Icons
Window 1, 2, ...

Creates a new window that views the profile.
Creates a new window with map view.
Creates new window with 3D view.
Arranges windows in an overlapped fashion.
Arranges windows in non-overlapped horizontal tiles.
Arranges windows in non-overlapped vertical tiles.
Arranges icons of closed windows.
Goes to specified window.

Help menu commands
The Help menu offers the following commands, which provide you assistance
with this application:
Help Topics
About

Offers you an index to topics on which you can get help.
Displays the version number of this application.

Toobars
Toolbars are providings shotcuts to most of the Mod3D commands to make your
work more comfortable.
Following toolbars are vailable:
Moo3D Toolbar
Profile Toolbar
Map Toolbar

Field Toolbar

Mod3D Toolbar

The toolbar is displayed across the top of the application window, below the
menu bar. The toolbar provides quick mouse access to many tools used in
Mod3D document.
To hide or display the toolbar, click Toolbar from the View menu.
Click To
Open a new document.
Open an existing document. Mod3D
displays the Open dialog box, in which you
can locate and open the desired file.
Save the active document or template with
its current name. If you have not named the
document, Mod3D displays the Save As
dialog box.
Print the active document.
Activate Zoom Out tool.
Activate Zoom In tool.
Activate Zoom tool.
Fit the view to the window size.
Open new Map View on the current
document.
Open new Profile View on the current
document.
Open new 3D View on the current
document.
Set equal scale for both axes.
Arrange all windows to non overlapping
vertical tiles.
Arrange all windows to non overlapping

horizontal tiles.
Initialize computing of model field.
Initialize digitize tool.
Force redrawing current view.

Map Toolbar.

The Map toolbar provides quick mouse access to tools used for work with Map
View. To hide or display the Map Toolbar, choose Model Toolbar from the View
menu. The Map Toolbar acts in Map View, if this is currently selected. If the
toolbar is not active, activate the Map View first by clicking inside the view.
Click To
Show observation points.
Show / hide current profiles.
Show relief contours.
Show relief bitmap.
Show / hide objects.
Show / hide body outer
contours.

Profile Toolbar.

The Profile Toolbar provides quick mouse access to tools used for work with
within Profile View . To hide or display the Model Toolbar, choose Model
Toolbar from the View menu. The Model Toolbar acts in Profile View, if this is
currently selected. If the toolbar is not active, select the Profile View first by
clicking inside the view.
Click To
Set vertical profile type.
Set horizontal profile type.
Move to the previous profile.
Move to the next profile.
Show previous profile bodies.
Show next profile bodies.
Show vertical grid lines.

Field Toolbar

The Field toolbar is default displayed across the right of the application window.
To hide or display the toolbar, click Field Toolbar from the View menu. The
Field Toolbar provides quick mouse access to the tools used to show or hide
modeled or measured field. The field toolbar acts on both Map View and Profile
View, depending on which view is currently selected. The command shows or
hides profile curve in Profile View, contours or bitmaps of selected field in map
view. If the toolbar is not active, select the view first by clicking inside the view.
Click To
Activate contours. Available in Map View only.
Activate bitmaps. Available in Map View only.
Activate modeled field.
Activate measured field.
Activate difference field.
Activate axis. Available in Profile View only.
Active field can be selected to the field axis.
Gravity field components
Show or hide Gx field.
Show or hide Gy field.
Show or hide Gz field.
Show or hide G field.
Magnetic field componenst
Show or hide Mx field.
Show or hide My field.
Show or hide Mz field.
Show or hide M field.
Gravity field derivatives tensor
Show or hide Txx field.

Show or hide Tyy field.
Show or hide Tzz field.
Show or hide Txy field.
Show or hide Txz field.
Show or hide Tyz field.

Model Properties
Observations
Minimum: Read only. Minimum observation grid coordinates.
Maximum: Read only. Maximum observation grid coordinates.
Increment: Read only. Observation grid cell size.
Top: Model vertical range.
Bottom: Model vertical range.
Creation Properties - Creation group defines how a new part of a body will be
created.
Join group defines how new part of the body will interacts with its
neighbors.
None: means that there will be no interaction with neighboring bodies.
Except of the system will not allow body intersections.
Top: the body will be connected to the closest upper body or relief (if
there is no body present).
Bottom: the body is going to be connected to the closest underlying
body, or bottom model boundary.
Const top: the top boundary has constant depth value if this is not in
contradiction with another body. Set the depth value.
Const bottom: the bottom boundary has constant depth value if this is
not in contradiction with another body. Set the depth value.
Body creation ratio: defines how new part of a body is created. If the
value is smaller then 1.0 the body is shrinking. NewThickness =
BodyCrationRatio*OldThickness. New body edge is centered over the
mouse position.
Motion group defines how the body is moving.
Move on current profile: the body is movable only on current profile.
Move top boundary: top boundary is movable.
Move bottom boundary: only bottom boundary is movable.
Fix relief: the top-most body is fixed to the relief.
Fix bottom: the bottom-most body is fixed to the bottom.

Extension
Extend boundaries to the sides to avoid boundary effects. If not checked
extension is not assumed.
North: specify extension length. Must be positive value.
South: specify extension length. Must be positive value.
East: specify extension length. Must be positive value.
West: specify extension length. Must be positive value.

Model Description
Enter description of the model. New line - CTRL + ENTER.

Computing properties dialog box.
Computation
If Spherical computing is checked, the whole computation is done on
spherical Earth. It needs additional transformations, which slow down
computation speed.
Extend edges to avoid boundary effects. The model continues further in the
same manner as it is defined on the edge profile. Give the distance of
extension in m.
Real-time Computation can be performed in three modes.
None: real-time computation is not active. The field must be
recomputed manually. This mode is efficient in initial stages of model
creation. Model creation is not slowed down with re-computing.
Real-time: field update is performed simultaneously as the mouse is
moving. All active grids are updated. All views are updated. Can be
slow for large models, or slow computers. Doesn't work for whole
body motion! See Efficient computing for details, how to achieve the
best computation efficiency.
After Mouse Click: the fields are updated after mouse button is
released. All active grids are updated. All views are updated. See
Efficient computing for details, how to achieve the best computation
efficiency. Doesn't work for whole body motion!
Window: set the area, which is recomputed. Only grid points within the
computing window are recomputed. Attention! You need to re-compute the
whole model after the window change.
Gravity
Units: Choose units you want to use.
Reference density: If you want to use absolute density for bodies (2700
kg/m3) set the reference density - recommended. The density is used for
computation is then: DensComputation = DensityBody RefererenceDensity. If reference density is 0.0 then is ignored, you can use
relative densities. Reference density can be also linearly increasing. Then
set the density gradient and origin. If all the components of density gradient
vector are 0.0, linearly increasing density is ignored. The reference density
is applied to the bodies itself (not to the whole volume).

Gradients tensor: Set either constant flight elevation or height over relief
where the field is to be computed.
Magnetics
Sensor over relief: set the sensor height over relief for magnetic field
computation.
Set Inducing Field for magnetic field computation.
< />

Body Properties: Gravity
Set the physical properties used for the gravitational field computation.
Density: specify the density of a body - robody in [kg·m-3]. Gravitational field is
computed using the reference density roref , if the reference density is nonzero.
The density used for computation is: ro = robody-roref .
Gradient: specify the density gradient components of a body in kg·m-4. Take
into account, that right-handed coordinate system with positive z-axis pointing
upward is used (for increasing density with the depth z component of the
gradient is negative). The z density gradient component can be computed as
follows: gz = (roH0-roH)/(h0-h), where roH0, roH is the density at
depth h0, h respectively.
Origin: Specify an origin for the density gradient computation. In the origin the
density equals to the density of a body. The density in point P is computed as
follows: roP = robody+ r·g, where g is the density gradient and r is the radius
vector from point P to the gradient origin.

Body Properties: Magnetics
Set the physical properties for the magnetic field computation.
Susceptibility: Set the susceptibility of the body in [SI] units dimensionless number equal to (1- m r) where m r is
the magnetic permeabity of the body relative to the vacuum. Magnetic
field is computed using the inducing field specified Model / Inducing field
menu.
Remanent Magnetization - Intensity: Set the intensity of the remanent
magnetization in [nT].
Remanent Magnetization - Inclination: Set the inclination of the
remanent magnetization in [degrees].
Remanent Magnetization - Declination: Set the declination of the
remanent magnetization in [degrees].

Body Properties: Drawing
Line: Set the line properties of the body. See
Line Next: Set the line properties for this body contours from next profile.
Line Prev: Set the line properties for this body contours from previous
profile.
Fill: Set the fill properties. Fill color is also used id 3D View to draw the
body, either wireframe or filled.
Transparent: Set the transparency for 3D View. Floating point alpha value
MUST fit the interval <0, 1>. For alpha=0 the body is invisible, for alpha=1
the body is opaque.
Filled: Specify if the body is filled in Profile View.
Visible in 3D: Specify, if the body should be displayed in 3D View.

Body Properties: Computation
Active: If checked, the body is active in computation, otherwise the body is
excluded from computation.
Locked: The body shape cannot be modified.

Body Properties - Description
ID is internal system identification. Read only.
Name: enter body name. This name will be displayed in all dialogs as body
identification.
Description: Enter your desription or notes.

Computation properties: Computation
If Spherical computing is checked, the whole computation is done on spherical
Earth. It needs additional transformations, which slow down computation speed.
Real-time Computation can be performed in modes.
None: real-time computation is not active. The field must be recomputed
manually. This mode is efficient in initial stages of model creation. Model
creation is not slowed down with re-computing.
Real-time: field update is performed simultaneously as the mouse is
moving. All active grids are updated. All views are updated. Can be slow
for large models, or slow computers. Doesn't work for whole body motion!
See Efficient computing for details, how to achieve the best computation
efficiency.
Window: select grid window used in computation. Only grid points within the
computation window are recomputed. Attention! You need to re-compute the
whole model after the window change.

Computing properties: Gravity
Sensor over relief [m]: Specify the sensor height over relief in meters. MUST
NOT be negative.
Units:Choose units you want to use. If custom units are used, the resulting field
is multiplied by the supplied value, which MUST NOT be zero (0.0).
Reference density: If you want to use absolute density for bodies (2700 kg/m3)
set the reference density - recommended. The density used for computation
is then: DensComputation = DensityBody - RefererenceDensity. If reference
density is 0.0 then reference density is ignored, you can use relative densities.
Reference density can be also linearly increasing. Then set the density gradient
and origin. If all the components of density gradient vector are 0.0, linearly
increasing density is ignored.
Note: The reference density is applied to the bodies itself (not to the whole model
volume).
Gradients tensor: Set either constant flight elevation or height over relief where
the field is to be computed. Multiply resulting field by supplied value (i.e.
displaying purposes, unit conversion...), which MUST NOT be zero (0.0).

Magnetics
Sensor over relief: set the sensor height over relief for magnetic field
computation.
Set Inducing Field for magnetic field computation.
< />

Profile View
The Profile View provides an interface, where the polyhedral bodies are defined
in sets of perpendicular cross sections running through the grid nodes. More
profiles can be opened simultaneously, to get better overview over the geometry
in both south-north and west-east directions respectively. Copying of the bodies
or the whole cross section to the next or previous profile followed up by
reshaping of the geometry speeds up the process of model creation. Profile View
also shows curves of computed and/or measured and/or difference fields. More
fields can be drawn transparently. Geo-referenced bitmaps could be imported
into Mod3D, and drawn transparently to the Map View or Profile View. An
example would be a geological map shown in Map View, or a seismic section
displayed in a selected Profile View. Main geological units could be digitized in
Map View, which are shown as check marks to achieve better orientation in the
Profile View. The model definition system controls internally the consistency of
the polyhedra geometries, or their topology in other words. The controlling
system prevents overlapping or crossing of the polyhedra, simplifies reshaping
of the existing bodies and reduces time needed for model creation.
Model Modification
SeeHow to Create / Modify the model? for detailed description.
Field Curves
Field curves on current profile are shown by default in following manner:
Modeled field for gravity and magnetics - solid line.
Modeled field for gravity tensor components - dashed line.
Measured field - cross symbols.
Difference field - dashed line.
See Field Toolbar for details how to show / hide field curves.
RMS & DRV Indicators
RMS indicator shows the Root Mean Square error of the currently selected
difference field(s). To show or hide the RMS indicator use command from menu
Profile \ Show RMS.
DRV indicator shows the "fake derivative" of the currently selected difference
field(s). To show or hide DRV indicator use command from menu Profile \ Show
Derivative. Fake derivative is an approximation of the exact derivative and is
computed as sum(dFld / dx + dFld / dy) over all points, where dFld=(Fld(i)-

Fld(i-1)) and Fld(i) is the selected field in the ith grid point.
Profile View floating menus.
Depending on where the user clicks the left mouse button, one can open
following floating menus:
Profile View menu. The default menu displayed, when user click out of
any object.

Menu Item
Next
Previous

Shortcut Description
N
Moves to the next profile.
P
Moves to the previous profile.
Changes the profile orientation to
E-W Profile H
East-West.
Changes the profile orientation to
S-N Profile V
South-North.
Show
Shows bodies from prom previous
Previous
profile on the current profile.
Shows bodies from next profile on
Show Next
the current profile.
Goes to the profile, where the
Jump to
E
extreme of the selected extreme field
Extreme ,
I
is located. To set the extreme field
Min, Max
A
use command Profile \ Set Extreme
Field.

Body menu. Is displayed when user clicks over the body.

Menu Item
Properties
Fill
Copy to
Previous
Profile
Copy to Next
Profile
Remove
Remove from
Profile
Edit Bodies
Body Creation
Properties:

Description
Shows current body properties.
Sets the fill tag.
Use this command to copy the body from
current profile to the previous profile. In
case of conflict, the problematic vertex is
ignored.
Use this command to copy the body from
current profile to the next profile. In case of
conflict, the problematic vertex is ignored.
Active only if the cursor is over edge
(either boundary edge or inner edge).
Removes the body from the current profile.

Activates Edit Bodies dialog.
Use this command to set the body creation
properties.
Use this command to invert the density of
Invert Density the current body. From more details see:
Invert Density Properties dialog.
Density
Inversion
Set the settings for density inversion.
Properties
Body Vertex menu. Is displayed, when user clicks over body vertex.

Fit
Start the vertex fitting.
1D Fit Properties Adjust the settings for 1D vertex fitting.
Body Edge. Is the same as Body menu.
Insert Body menu. Is displayed, when the user clicks over vertical line,
where the body can be inserted.

Insert New Body
Insert Existing
Body
Edit Bodies
Body Creation
Properties

Inserts new body to the specified
position.
Inserts existing body to the spefied
position.
Activates Edit Bodies dialog.
Use this command to set the body
creation properties.

Axes
Right mouse button click on the axis activates the axis properties.
Use left button down + mouse move to scale the axis interactively.
Shortcuts
Use mouse wheel or arrow keys to move over the model.

Map View Properties
Image Quality slide adjusts the image quality. Higher image quality slow down
view updating. It is recommended to use lower quality in real-time computation.
Show
Observation points Show / hide observation points.
Observation bitmap Show / hide relief bitmap.
Observation contours Show / hide relief bitmap.
Imported objects Show / hide all imported objects.
Profiles Show / hide profiles in Profile View.
Horizontal grid lines Show / hide horizontal grid lines.
Vertical grid lines Show / hide vertical grid lines.
Bodies boundaries Show / hide outer body boundaries.
Equal scale for both axes
If checked AND not zoomed scale for axes is equal. When zoomed this option
does not have effect.

3D View
3D View shows 3D projection of the model, imported objects and fields. It also
allows to user modify the geometry of the model. Two main modes are
supported.
Rendering mode is used to visualize the model. Selection and motion of the
vertices is disabled. To rotate, shift or zoom the model use following commands.
Command
right mouse button down
left mouse button down
+ mouse move
SHIFT + left mouse
button down + mouse
move
mouse wheel
CTRL + mouse move
key LEFT, RIGHT
key UP, DOWN
key Page Up, Page
Down
E
W
N
S
M

Action
Opens 3D View property sheet.
Rotates the model.
Shifts the model.
Zooms the model.
Zooming.
Rotates the model about the
vertical axis.
Zooms the model.
Shift the model along vertical axis.
Set the view from E to W.
Set the view from W to E.
Set the view from N to S.
Set the view from S to N.
Map View.

Selection mode is used for interactive modification the model in 3D. The table
below describes the commands used in modification, which differs from the
rendering mode (previous table).
Command
Action
CTRL + left mouse

button down + mouse
move
CTRL + SHIFT + left
mouse button down +
mouse move
left mouse button click
on body vertex + mouse
move

Zooms the model.

Rotates the model.
Moves the body vertex along
vertical. See model modification
for details.

Status Bar
The status bar is displayed at the bottom of the Mod3D window. To display or
hide the status bar, use the Status Bar command in the View menu.
The left area of the status bar describes actions of menu items as you use the
arrow keys to navigate through menus. This area similarly shows messages that
describe the actions of toolbar buttons as you press them, before releasing them.
If after viewing the description of the toolbar button command you wish not to
execute the command, then release the mouse button while the pointer is off the
toolbar button.
The right areas of the status bar indicate which of the following keys are latched
down:
Indicator
%
row
col
x
y
z

Description
Shows computing progress...
Shows current row.
Shows current column.
Actual x coordinate.
Actual y coordinate.
Actual z coordinate.

field

Actual field value for given row
and column.

What is Mod3D?
Mod3D is an interactive 3D geophysical gravity and magnetic
modeling software.
Mod3D has been developed to create 3D geophysical models in an user friendly
interactive environment. Anomalous gravity and/or magnetic fields are
computed using formulae for polyhedral bodies. The Map View, Profile View and
3D View are provided on modeled half-space. The Map View provides an
overview on the model geometry projected to the horizontal plane, and shows
bitmaps or contours of modeled field grids and topography. The Profile View
provides an interface, where the polyhedral bodies are defined in sets of
perpendicular cross sections running through the grid nodes. More profiles can
be opened simultaneously, to get better overview over the geometry in both
south-north and west-east directions respectively. Copying of the bodies or the
whole cross section to the next or previous profile followed up by reshaping of
the geometry speeds up the process of model creation. Profile view also shows
curves of computed and/or measured and/or difference fields. Geo-referenced
bitmaps could be imported into Mod3D, and drawn transparently to the Map
View or Profile View. An example would be a geological map shown in Map
View, or a seismic section displayed in a selected Profile View. Main geological
units could be digitized in Map View which are shown as check marks to achieve
better orientation in the Profile View. The model definition system controls
internally the consistency of the polyhedra geometries, or their topology in other
words. The controlling system prevents overlapping or crossing of the
polyhedra, simplifies reshaping of the existing bodies and reduces time needed
for model creation.

How To
Begin?
Create / Modify the model?

New command (File menu)
Use this command to create a new document in Mod3D.
You can open an existing document with the Open command.

Open command (File menu)
Use this command to open an existing document in a new window. You can open
multiple documents at once. Use the Window menu to switch among the
multiple open documents. See Window 1, 2, ... command.
You can create new documents with the New command.

Close command (File menu)
Use this command to close all windows containing the active document. Mod3D
suggests that you save changes to your document before you close it. If you
close a document without saving, you lose all changes made since the last time y
ou saved it. Before closing an untitled document, Mod3D displays the Save As
dialog box and suggests that you name and save the document.

Save command (File menu)
Use this command to save the active document to its current name and directory.
When you save a document for the first time, Mod3D displays the Save As
dialog box so you can name your document. If you want to change the name and
directory of an existing document before you save it, choose the Save As
command.

Save As command (File menu)
Use this command to save and name the active document. Mod3D displays the
Save As dialog box so you can name your document.
To save a document with its existing name and directory, use the Save command.

Import command (File Menu)
Use this command to import various objects as grids, bitmaps, guiedlines.
Measured Field
Bitmap
Guideline
Body

Imports new measured field grid
Imports a bitmap image.
Imports a gudeline.
Imports body.

Print command (File menu)
Use this command to print a document. This command presents a Print dialog
box, where you may specify the range of pages to be printed, the number of
copies, the destination printer, and other printer setup options.
In development! May produce errors!

Print Preview command (File menu)
Use this command to display the active document as it would appear when
printed. When you choose this command, the main window will be replaced with
a print preview window in which one or two pages will be displayed in their
printed format. The print preview toolbar offers you options to view either one
or two pages at a time; move back and forth through the document; zoom in and
out of pages; and initiate a print job.

Print Setup command (File menu)
Not fully supported!
Use this command to select a printer and a printer connection. This command
presents a Print Setup dialog box, where you specify the printer and its
connection.

Exit command (File menu)
Use this command to end your Mod3D session. You can also use the Close
command on the application Control menu. Mod3D prompts you to save
documents with unsaved changes.

Toolbar command (View menu)
Use this command to display and hide the toolbar, which includes buttons for
some of the most common commands in Mod3D, such as File Open. A
checkmark appears next to the menu item when the toolbar is displayed.
See Toolbar for help on using the toolbar.

Status Bar command (View menu)

Use this command to display and hide the status bar, which describes the action
to be executed by the selected menu item or pressed toolbar button, and
keyboard latch state. A checkmark appears next to the menu item when the status
bar is displayed.
See Status Bar for help on using the status bar.

1, 2, ... command (Window menu)
Mod3D displays a list of currently open document windows at the bottom of the
Window menu. A checkmark appears in front of the document name of the
active window. Choose a document from this list to make its window active.

Index command (Help menu)
Use this command to display the opening screen of help. From the opening
screen, you can jump to step-by-step instructions for using Mod3D and various
types of reference information.
Once you open help, you can click the Contents button whenever you want to
return to the opening screen.

About command (Help menu)
Use this command to display the copyright notice and version number of your
copy of Mod3D.

File Save As dialog box
The following options allow you to specify the name and location of the file
you're about to save:
File Name
Specifies a file name to save a document with a different name. Mod3D adds the
extension you specify in the Save File As Type box.
Drives
Specifies the drive in which you want to store the document.
Directories
Specifies the directory in which you want to store the document.
Network
Click this button to connect to a network location, assigning it a new drive letter.

Import Measured Field command (File \ Import menu)

Import Bitmap command (File \ Import menu)

Import Guideline command
Use this command to import guideline. Guideline is an object, which sipmlifies
the orientation over the observation area. Guideline is shown on both Map View
and Profile View. In Profile View is shown the intersection of the current profile
with guideline(s). Guideline can be imported from text filewith format described
below.
Gudeline file format:
keywords: line [name] describes the begining of guideline; name parameter
is optional but recomended and is string shown on Profile View as a description
of guideline.
After lineline [name] keyword follows data section. Data section can contain
n floating point numbers in on line. First coordinate is x followed by y and z
coordinates. First two are necassary for valid piont. Third, z coordinate can be
omited.
*** file "guideline.dat" *******
line sampleGL
100 100 10
150.1 200.5 8.6
....
....
....
line anotherGL
10 20
25 30
35 40
...
...
...
...
*** end of file "gudeline.dat" ****
Gudelines can be edited in guideline editor. To edit guideline choose from menu
Edit \ Edit Guideline.

Import Body command (File \ Import menu)

Print dialog box
The following options allow you to specify how the document should be printed:
Printer
Displays the active printer and printer connection. Choose the Setup option to
change the printer and printer connection.
Setup
Displays a Print Setup dialog box, so you can select a printer and printer
connection.
Print Range
Specifies the pages you want to print:
All
Prints the entire document.
Selection Prints the currently selected text.
Prints the range of pages you specify in the From and
Pages
To fields.
Copies
Specifies the number of copies you want to print for the above page range.
Collate Copies
Prints copies in page number order, instead of separated multiple copies of each
page.
Print Quality
Specifies the quality of the printing. Generally, lower quality printing takes less
time to produce.

Print Setup dialog box
The following options allow you to select the destination printer and its
connection.
Printer
Specifies the printer you want to use. Choose the default printer, or choose the
Specific Printer option and select one of the current installed printers shown in
the box. You install printers and configure ports using Control Panel.
Orientation
Specifies Portrait or Landscape.
Paper Size
Specifies the size of paper that the document is to be printed on.
Paper Source
Specifies the paper source, because some printers offer multiple trays for
different paper sources.
Options
Displays a dialog box where you can make additional choices about printing,
specific to the type of printer you have selected.
Network
Click this button to connect to a network location, assigning it a new drive letter.

